
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Business Analyst to Data Analyst 

SKILLSOFT ASPIRE JOURNEY 



Głównym wyzwaniem przed którym stają dziś 

organizacje na całym świecie jest konieczność 

ciągłego podnoszenia umiejętności i poziomu 

wiedzy w ślad za gwałtownym rozwojem 

nowych technologii i zmian na globalnym 

rynku. 

 

Stały rozwój i podnoszenie kwalifikacji w IT od 

dawna jest już rzeczą oczywistą, a możliwość 

zapewnienia wsparcia specjalistom chcącym 

stale się rozwijać jest jedną z głównych kart 

przetargowych w walce o pracownika. 

 

Na rynku liczą się dziś ludzie, którzy posiadają 

konkretne kompetencje i zestaw umiejętności 

pozwalający im wykonywać zadania 

efektywnie, a nie Ci z najdłuższym stażem 

pracy. 

 

Dziś, bardziej niż kiedykolwiek w cenie jest 

umiejętność budowania ścieżki kariery dla 

profesjonalistów IT, którzy wciąż chcą się liczyć 

na rynku pracy. 

Skillsoft Aspire Journey stanowi odpowiedź 

na pytanie, jakie szkolenia muszę ukończyć, 

aby być przygotowanym do mojej wymarzonej 

pracy. Spośród kilkuset kanałów tematycznych 

dostępnych na naszej platformie szkoleniowej 

nasi specjaliści wybrali te, które naszym 

zdaniem najlepiej wyposażą uczących się 

w narzędzia potrzebne do realizacji zadań 

w nowej roli. 

 

Skillsoft Aspire Journey to zestawy 

szkoleń i ćwiczeń w języku angielskim, które 

metodycznie, krok po kroku pozwalają 

specjalistom przejść od poziomu 

podstawowego do zaawansowanego. 

 

Każda ścieżka zawiera szkolenia, laboratoria 

wirtualne, video i książki, które pomogą 

uczącym się osiągnąć pożądane kompetencje 

poświadczone certyfikatem. 

 

Aspire Journey Model 

Cała ścieżka opiera się na 4-elementowym cyklu powtarzanym na kolejnych etapach nauki. 

 

1. Określenie kluczowych funkcji i wyzwań, z którymi musi poradzić sobie uczący się w chwili obecnej, 

jak i tymi, z którymi przyjdzie mu się zmierzyć w nowej pracy. 

2. Przejście zaprojektowanych ścieżek w proponowanej kolejności, wykonanie ćwiczeń i zaliczenie 

testów. 

3. Przećwiczenie nowych umiejętności w kontrolowanym środowisku w oparciu o gotowe 

scenariusze działań. Laboratoria wirtualne Skillsoft 

4. Certyfikat – zaliczenie testu końcowego na poziomie co najmniej 70% i uzyskanie certyfikatu 

potwierdzającego ukończenie danego etapu nauki. 

  



Aspire Journey – Business Analyst to Data Analyst 

Analizując trendy opisujące zachowanie użytkowników na naszych platformach szkoleniowych i współpracując 

ściśle z naszymi klientami na całym świecie Skillsoft wyselekcjonował najlepsze materiały szkoleniowe i ułożył 

je w ustrukturalizowaną ścieżkę rozwoju. Ścieżka zawiera około 48 godzin szkoleniowych. 

 

 

Track 1: Business Analyst 

 

8 courses | 9h 32m 57s |1 lab | 8h 

 

 

Track 2: Decision Analyst 

  

8 courses | 9h 54m 41s | 1 lab | 8h 

 

 

 

Track 3: Systems Analyst 

 

10 courses | 12h 10m 9s | 1 lab | 8h 

 

 

 

Track 4: Data Analyst 

 

12 courses | 16h 21m 32s | 1 lab | 8h 

 

 

PREREQUISITES 

In order to fully profit from the potential of this Aspire Journey, we recommend the following 

prerequisite skills: 

▪ Knowledge of data visualization tools 

▪ Knowledge of programming 

▪ Knowledge of databases  



 

Track 1: Business Analyst (duration: 9h 32m 57s) 

 
Complete Guide to 
Excel 365: Getting 

Started 

 
 
 
 

Objectives 
 

▪ launch Microsoft Excel, explore available templates, and customize the Quick Access Toolbar 
▪ explore different menu sections within the toolbar ribbon such as Page Layout, Formulas, 

Data, Review and View, and create a new ribbon tab 
▪ copy-paste data and use the Format Cells right-click menu option to customize number 

formatting, alignment, font, border, fill, and protection 
▪ insert and delete rows and columns, alter cell fill color and line borders, and merge cells via 

the Home menu 
▪ apply different currency formats, alter displayed number precision via the decimal point, 

copy-paste non-contiguous ranges, and rename sheets in an Excel workbook 
▪ use the Text Import Wizard to open text files with delimited columns, and open comma-

separated and tab-delimited text files using the Data import menu item 
▪ use the Text Import Wizard to open fixed-width files containing columns of fixed character 

numbers, create, delete, and move column breaks, and fix data that was incorrectly 
imported as fixed-width when it was delimited 

▪ recognize Flash Fill as a way to fill in missing data intelligently, import a file as an Excel data 
table, export workbooks to formats such as PDF/XPS, and identify the potential for data loss 
when a workbook is saved as a CSV file 

 

 
Complete Guide to 
Excel 365: Working 

With Charts & 
Sparklines 

 

Objectives 
 

▪ insert charts and customize chart elements, such as the axes, title, data labels, data callouts, 
and grid lines, and add analytical elements based on standard deviation, percentage, and 
standard error, such as trendlines and error bars 

▪ use the chart design item from the toolbar ribbon to change chart layout and color, switch 
rows and columns, change selected data and chart type, and control whether #N/As and 
empty cells are displayed as gaps or zeros 

▪ create charts that occupy an entire worksheet and control their appearance using worksheet 
functions, plot pie charts and alter transparency, glow, and other visual aspects, explode and 
re-orient sections of pie charts, and work with treemaps and sunburst charts 

▪ use histograms to summarize the statistical properties of data, bin data by category, bin 
width, or fixed number of bins, perform automatic binning, and set overflow and underflow 
bins 

▪ perform univariate EDA (exploratory data analysis), use box-and-whisker plots to plot the 
mean, median, inter-quartile range and outliers, and choose between inclusive and exclusive 
median methods in quartile calculation 

▪ perform bivariate EDA (exploratory data analysis), use scatter plots to examine relationships 
between two numeric data columns and the Chart Design menu to create linear, exponential, 
and other types of trendlines, and identify positively and negatively trending data 

▪ plot geographical data such as countries, states, counties, or postal codes using the Map 
chart type, use other chart types such 2-D and 3-D column and area charts, and combine 
multiple visualizations into a single chart using a combo chart type 

▪ construct at-a-glance visualizations using sparklines to build lightweight charts without axes 
or units contained within individual cells, and use named ranges to control data displayed in 
a sparkline visualization 

▪ contrast Line and Column sparklines, control the appearance of high, low, and negative 
points, apply custom formatting to first and last points, display data in reverse order, and use 
the Quick Access Toolbar to view undoable actions 



 
Complete Guide to Excel 
365: Using Formatting, 

Styles, & Themes 
 
 
 

Objectives 
 

▪ copy-paste formulas with relative cell references, use the Insert Function menu to see 
built-in worksheet functions, arguments, and results, and use the AutoFill options to 
control how copy-pasted data is handled 

▪ use keyboard shortcuts to insert line breaks and the date and time into a cell, set default 
fill behavior when copy-pasting dates and times, customize AutoCorrect options to control 
workbook proofing, extend built-in AutoCorrect rules to expand acronyms automatically, 
and work with fractions and percentages   

▪ use Excel's Comments feature to have threaded conversations, insert, show, hide, and 
delete notes and comments, and prevent metadata loss when converting notes to 
comments   

▪ recognize the #SPILL! error and data tables features, such as named columns, calculated 
columns, and headers, use data tables to filter, sort, and remove duplicate data, and 
convert to and from traditional Excel ranges 

▪ use the Conditional Formatting menu item to highlight cells based on rules, use relational 
operators (greater than, less than, between) and text and date filters, and visualize data 
properties by highlighting duplicates, top-N, bottom-N, above-average, and below-
average values   

▪ use data bars, color scales, and icon sets to create visually appealing, conditionally 
formatted spreadsheets, and depict directional data using arrows, shapes, ratings, and OK-
Warning-Error indicators   

▪ create new formatting rules and vary both conditions governed by the rule as well as 
precise formatting aspects, highlight outliers that lie a certain number of standard 
deviations from the mean, highlight unique and duplicate values, use the Find & Select 
menu item to locate all cells governed by conditional formatting rules, and clear 
conditional formatting rules   

▪ use formulas to determine which cells will be governed by a conditional formatting rule, 
the logical OR function to construct a boolean predicate to highlight weekends in a range 
of dates, and the ROW() function to alter highlighting based on cell location   

▪ use built-in cell styles and workbook themes, create new styles and themes, and export a 
theme for use in different MS-Office products 

  

 
Complete Guide to Excel 
365: Linking, Printing, & 
Protecting Workbooks 

 

Objectives 
 

▪ use the Excel Options menu to customize how workbooks are saved, configure AutoSave 
and AutoRecover behavior and the default save location, and use the Manage Workbook 
functionality to recover or delete unsaved workbooks 

▪ use built-in templates, save a commonly-used workbook as an Excel Template (.xltx) file, 
and recognize the purpose of the Custom Office Templates folder, the names "Book" and 
"Sheet" for .xltx files, and the XLSTART sub-folder 

▪ use the Data Outline menu item to logically group data based on rows and columns, the 
Ungroup option to undo grouped data, and list the capabilities and limitations of the 
Auto Outline feature 

▪ create links to external workbooks, use the Paste Link option from the Paste menu, parse 
the syntax of external link addresses, and recognize the dynamic nature of data linked 
from external workbooks 

▪ edit external links using the Data menu, use the Open Source, Check Status, Change 
Source, and Break Link options, and customize the startup prompt when a workbook 
with external links is opened 

▪ combine the Print and Page Layout menu features to control how workbooks are printed 
and use Page Break Preview to control pagination, specify collation, scaling, paper type, 
and orientation 

▪ customize headers and footers, display and hide hidden columns, insert images into 
workbooks, control whether images are printed and whether they appear within the 
data or in the header/footer, and set and customize a workbook's background image and 
transparency 

▪ use the Protect Sheet feature from the Review menu to control how a sheet can be 
edited, customize which operations are possible without a password, and use the Allow 
Edit Ranges feature to override protection for specific areas on a worksheet 

▪ control cell-level protection and understand the semantics of the locked and hidden 
checkboxes, apply workbook-level protection options 



 
Complete Guide to Excel 

365: Validating, 
Cleaning, & Performing 

Lookups on Data 
 
 

Objectives 
 
▪ Use absolute and relative cell references in worksheet formulae, lock cell references 

using the $ symbol and named ranges, and use the trace error feature to debug 
formula errors   

▪ analyze data using the Subtotal feature, specify when the subtotal function should be 
applied, compute group summaries and grand totals, and remove changes to the 
workbook made by the Subtotal menu  

▪ use the Filter feature from the Data menu to focus on specific subsets of data, 
illustrate how Filter and Subtotal differ in making changes to a workbook; identify and 
avoid circular references using Excel Error Checking   

▪ perform conditional analysis using the IF() function, and combine logical conditions 
using the AND() and OR() functions 

▪ use conditional aggregate functions, such as COUNTIF() and COUNTIFS(), to perform 
aggregate operations based on specific conditions and recognize the semantics of 
predicates created from strings for use within these functions   

▪ utilize VLOOKUP() and HLOOKUP() functions for one-dimensional lookups that join 
data ranges based on a common column, then use relative cell references for the 
lookup value and absolute cell references for the lookup range  

▪ use the INDEX() and MATCH() functions to perform two-dimensional lookups and nest 
two calls to MATCH() within a single call to INDEX() to match on both row and column   

▪ implement common data-cleaning operations, such as eliminating duplicates via the 
Data menu, use CLEAN() to remove unwanted whitespace characters, correctly 
interpret numbers stored as text, and use CONVERT() for an extensive range of unit 
conversion operations   

▪ work with external hyperlinks and parse them using string functions, such as RIGHT(), 
LEFT(), MID(), SUBSTITUTE() and LEN(), and fill in blank/missing values using the Find 
& Select menu option and the Go To Special feature   

▪ specify data validation constraints, configure bounds on acceptable values, create 
user-friendly error messages, and validate data based on decimal, whole number, text 
length, and date/time values   

▪ create lists for use in data validation and use named ranges and the INDIRECT() 
function to create a robust and dynamic data validation mechanism   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
Complete Guide to Excel 

365: What-If Analysis, 
Solver, & Analysis 

ToolPak 
 

Objectives 
 

▪ Use the What-If Analysis feature in Excel, create scenarios based on specific cell values, 
assign names to these scenarios, and toggle between them, summarize a range of 
outcomes across scenarios by performing What-If Analysis, and interpret the returned 
results   

▪ use Goal Seek for solving simple univariate optimization problems, such as solving 
univariate equations where a target output cell must be set to a specific value by 
changing a single input cell 

▪ enable the Solver add-in and use it to perform complex multi-variable optimization, 
specify objective functions to min/max or specific values, and specify non-negativity 
conditions and solution methods for contraints 

▪ perform simple statistical analysis of two-dimensional data, compute measures of 
central tendency (mean, median, mode) and dispersion (standard deviation and 
variance), define Bessel's correction, and calculate skew and kurtosis   

▪ enable Analysis ToolPak and use it to compute correlation and covariance matrices, 
interpret the results, and recognize the link between covariance and variance 

▪ implement hypothesis testing using the Analysis ToolPak, perform the two-sample F-test 
for variance equality and two-sample t-test for equality of means, and interpret the 
significance level (alpha), test statistic, and p-value 

▪ implement ANOVA (Analysis of Variance) using Analysis ToolPak to analyze variances 
within and between groups   

▪ use Analysis ToolPak for histogram analysis and descriptive statistic computing, compute 
ranks and percentiles, and perform both random and periodic sampling   

▪ generate random numbers drawn from various distributions using Analysis ToolPak, 
apply normal, Bernoulli, Poisson, and other distributions, specify population parameters, 
such as mean and variance, and recognize why sample mean and variance might differ 
from them   

▪ perform linear regression using Analysis ToolPak, interpret the results of regression 
including R-square, p-values, and t-statistics of individual regression coefficients, and 
identify the benefits of using Analysis ToolPak over worksheet functions such as 
LINEST(),SLOPE(), and INTERCEPT()   

 

 
Complete Guide to Excel 
365: Pivot, PowerPivot, 
& Financial Modeling 

 
 
 
 

 

Objectives 
 
▪ import data in relational (tabular) form, create pivot tables by attempting to link multiple 

tables, and specify issues that can arise if pivot tables are created without accurately 
capturing relationships   

▪ auto-detect relationships using the PivotTable feature, and illustrate how foreign key 
relationships between parent and child tables are detected and dynamically reflected in 
pivot tables   

▪ use PowerPivot to detect and manage relationships, create data models, and inter-
operate with traditional Excel pivot tables   

▪ contrast the auto-detection of relationships performed in PowerPivot vs. in traditional 
pivot tables, visualize foreign-key relationships, and use entity-relationship diagrams in 
PowerPivot   

▪ model fixed-income instruments, such as bonds using Excel's financial functions, use the 
EDATE() function to compute settlement dates, the EFFECT() function to find effective 
compounding rates, and the FV() function to compute the future value of a stream of 
cash flows   

▪ compute the yield of a bond using the YIELD() function, demonstrate the inverse 
relationship between prices and yields, and use the PV() function to find the present 
value of a series of cash flows   

▪ perform NPV (net present value) calculations using both the Excel NPV() function and 
hand-rolled formulas that take into account the discount rates and coupons of a fixed 
income instrument   

 



 
Final Exam: Business 

Analyst 
 
 

 
 
 

Objectives 
 
▪ analyze data use the Subtotal feature from the Data menu 
▪ and create pivot tables by attempting to link multiple such tables 
▪ apply custom formatting to first and last points 
▪ apply workbook-level protection options such as open in read-only mode, 

encrypting with the password, add a digital signature, and marking as final 
▪ Auto-detect relationships between different relations use the PivotTable feature 
▪ bin data by category, by bin width, or by specifying a fixed number of bins 
▪ combine multiple visualizations into a single chart using the combo chart type 
▪ combine the Print and Page Layout menu features to precisely control how 

workbooks are printed 
▪ configuring AutoSave and AutoRecover behavior and the default save location 
▪ construct at-a-glance visualizations use Sparklines to construct lightweight charts 

without axes or units contained within individual cells 
▪ contrast Comments and Notes in Excel 
▪ Copy-paste data and use the Format Cells right-click menu option to customize 
▪ Correctly utilize absolute and relative cell references in worksheet formulae 
▪ create links to external workbooks use the Paste Link option from the Paste menu 
▪ create new formatting rules and varying both conditions governed by the rule as 

well as precise formatting aspects 
▪ customize headers and footers 
▪ customize that ribbon by creating a new ribbon tab 
▪ customize the quick-access toolbar 
▪ edit external links use the Data menu 
▪ Efficiently and quickly perform simple statistical analysis of two-dimensional data 
▪ enable Analysis ToolPak 
▪ enable Analysis ToolPak and use it to compute correlation as well as covariance 

matrices 
▪ enable the powerful Solver add-in 
▪ export workbooks to formats such as PDF/XPS 
▪ generate random numbers drawn from various distributions use Analysis ToolPak 
▪ identify the capabilities and limitations of the Auto Outline feature 
▪ implement ANOVA (Analysis of Variance) use Analysis ToolPak to analyze 

variances 
▪ implement ANOVA (Analysis of Variance) use Analysis ToolPak to analyze 

variances within groups and between groups 
▪ implement common data-cleaning operations such as the elimination of 

duplicates via the Data menu 
▪ implement hypothesis testing 
▪ Insert and delete rows and columns 
▪ insert charts and customize Chart Elements such as the axes, title, data labels, 

data callouts, and gridlines 
▪ introduce Excel Data Tables and understand the #SPILL! Error 
▪ introduce the use of worksheet formulas and the semantics of copy-pasting 

formulas with relative cell references 
▪ Launch Microsoft Excel, explore available templates, and customize the quick-

access toolbar 
▪ open comma- and tab-delimited text files use the Data Import menu item 
▪ perform conditional analysis use the worksheet IF() function 
▪ perform univariate EDA (exploratory data analysis) use box-and-whisker plots 
▪ recognize different charts 
▪ recognize the pitfalls of create such pivot tables without accurately capturing 

relationships between relations 
▪ recognize the role of PowerPivot in analytical Big Data processing 
▪ specify Data Validation constraints to prevent typos and reduce the need for data 

cleaning 
▪ understand the pitfalls of create such pivot tables without accurately capturing 

relationships between relations 



▪ understand the role of PowerPivot in making Excel a powerful tool for analytical 
Big Data processing 

▪ use built-in templates and saving a commonly-used workbook as an Excel 
Template (.xltx) file 

▪ use conditional aggregate functions such as COUNTIF() and COUNTIFS() to 
perform aggregate operations based on specific conditions 

▪ use Excel's powerful functionality for filling in blank/missing values use the Find 
& Select menu option and the Go To Special feature 

▪ use Goal Seek for solving 
▪ use keyboard shortcuts to insert line breaks inside a cell 
▪ use scatter plots to examine relationships between two numeric data column 
▪ use the Chart Design item from the toolbar ribbon to quickly change chart layout 

and color 
▪ use the Conditional Formatting menu item to highlight cells based on rules 
▪ use the Filter feature from the Data menu to focus on specific subsets of data 
▪ use the INDEX() and MATCH() functions to perform two-dimensional lookups 
▪ use the logical OR function to construct a boolean predicate that can be used to 

highlight weekends in a range of dates 
▪ use the Protect Sheet feature from the Review menu to control how a sheet can 

be edited 
▪ use the ROW() function to alter highlighting based on cell location 
▪ utilize the powerful and popular VLOOKUP() and HLOOKUP() functions for one-

dimensional lookups that join ranges of data based on a common column 
▪ utilize the What-If Analysis feature in Excel 
▪ visualize foreign-key relationships use entity-relationship diagrams in PowerPivot 

 

 

 Business Analyst Lab 
 

  



 

Track 2: Decision Analyst (duration: 9h 54m 41s) 

 
Tableau for Data 

Visualization: 
Introduction 

 

Objectives 
 
▪ download the public version of Tableau and install it on your machine 
▪ load data from a variety of file types into Tableau in order to perform an analysis 
▪ prepare your data for visualization by applying transformations, which are more 

meaningful for data analysis 
▪ recognize the properties of your data in order to choose the appropriate visualizations 

for analysis 
▪ analyze information in multiple data tables related to one another 
▪ generate a basic visualization in order to analyze categories of data 
▪ define the aesthetics of a Tableau chart in order to make it easier to analyze 
▪ gather detailed information from Tableau charts by interacting with them 
▪ perform some basic data cleaning on your datasets using the Tableau data interpreter 

 

 

 

 
Tableau for Data 

Visualization: Exploring 
Visualizations & Data 

Formats 
 

 

Objectives 
 
▪ enrich your visualizations by conveying additional information using text 
▪ convey information from multiple fields in your dataset using a variety of markers 
▪ portray different characteristics of your data by using a variety of charts available 

in Tableau 
▪ plot the changes in your data over time by using the Pages feature 
▪ enable users to drill down in your visualizations by arranging related fields in a 

hierarchy 
▪ recognize the different ways in which hierarchy definitions could lead to incorrect 

visualizations 
▪ analyze your data at a higher level and drill down to a lower level based on a date 

field 
▪ gather together related elements in your visualizations using groups 
▪ create a table which analyzes sales data along 3 different dimensions 
▪ flatten a multi-dimensional table using a combined field 
▪ define a field in your dataset which is based on a calculation performed on an 

existing field 
▪ combine related data points into a set to analyze data within and outside the set 

 

 

 

 



 
Tableau for Data 

Visualization: Advanced 
Features 

Objectives 
 
▪ plot country-related information on a Tableau Map 
▪ configure the appearance of a map and explore the use of map layers 
▪ generate multiple charts based on the same dataset for use in a dashboard 
▪ create a dashboard and explore the various layouts available for the placement of 

objects such as charts 
▪ embed an interactive web page, navigation button, and text label in a dashboard 
▪ set the aesthetics of a dashboard and include an option for the user to download the 

dashboard to a local file 
▪ develop a story to convey information in the form of visualizations by assembling charts 

and a dashboard 
▪ share a story with the general public by publishing it to Tableau 

 

 
Business Reporting: 
Getting Started with 
Power BI Desktop for 

Data Analysis 
 
 

Objectives 
 
▪ install Power BI from Microsoft Store and import data to it from an Excel file 
▪ perform operations in Power BI using the UI and the Advanced Editor to sort data, 

change data types, rename columns, and use uppercase text 
▪ perform operations in Power BI to remove columns and top rows, split columns by 

delimiter, filter rows, and delete a query 
▪ create basic and advanced filters in Power BI to filter data using a condition on one 

or more columns 
▪ create bar charts in Power BI, sort the values visualized in them, and edit the 

operations Power BI performs on the visualized data 
▪ edit the aesthetics of a bar chart, changing the color, display units, orientation, 

height, width, and more 
▪ import JSON data into Power BI and use Power Query to convert JSON data into 

tabular data and change the column data types 
▪ create and edit a line chart in Power BI by adding and configuring data labels, 

legends, markers, gridlines, and other chart elements 
▪ use Power BI to design a stacked bar chart for data visualization and fields with large 

numbers of unique values and create a basic filter using the filters pane 
 

 

 

 

 

  



 
Business Reporting: 

Visualizing & Merging 
Data in Power BI 

 

Objectives 
 
▪ use Power Query to create conditional calculated columns using if-else-elif blocks and 

custom calculated columns using formulas to determine values 
▪ import XML data to Power BI, filter it, change the data type, and find and delete rows 

with errors 
▪ Use Power BI to build and edit stacked line charts, configure aspects of them, such as 

the legend and axes, and create a basic filter in the filters pane 
▪ configure the filters pane in Power BI to automatically filter based on the specified filter 

value 
▪ create a foreign key relationship (a.k.a., a referential integrity constraint) between two 

tables in Power BI 
▪ Use Power BI to create a bar chart with lines parallel to the axes using the analytics card, 

and configure min, max, median, and average lines 
▪ combine files in an imported folder and perform basic data cleaning operations using 

Power BI's UI and Advanced Editor 
▪ perform various advanced Power Query operations, such as removing columns and Top 

N and error rows, performing row filtering operations, and creating grouped bar charts 
 

 

 
Business Reporting: 

Creating & Formatting 
Matrix Visualizations in 

Power BI 
 

 

Objectives 
 
▪ create a relationship between two tables in Power BI and enable automatic detection 

of these relationships 
▪ disable automatic detection of relationships between tables in Power BI and manually 

create and edit relationships between tables 
▪ experiment with 1:1, Many: Many, 1:Many, and Many:1 table relationships and create 

relationships among tables by dragging and dropping columns 
▪ use the Power BI Report View to visualize data that has been imported from an Excel 

spreadsheet and instantiate a matrix visualization in the report view 
▪ populate the matrix visualization using the State and Values field inputs from the 

Visualizations tab; perform aggregation operations on the Values field; and leverage 
the Page Information, Page Size, and Page Background cards from the context-
sensitive Format Control tab to control color, transparency, and layout of the Power 
BI report page 

▪ enable a matrix to drill down to a specific level and then disable the matrix from having 
a drill-down 

▪ drill down data rows in matrix visualizations and apply a filter to drill down into a 
particular row using the drill-down button 

▪ perform sort operations on the rows and drill-down and drill-up operations on the 
rows and columns of matrix visualizations 

▪ create a column calculated from a formula using a new measure 
▪ leverage the Visualizations pane's context-sensitive Format Control tab to control the 

field hierarchy alignment, font color, gridlines, computation, and position of subtotals 
and outline color of a matrix control using the Title, Column Headers, Rows, and 
Subtotals cards 

▪ apply conditional formatting and add data bars with custom colors to a matrix, then 
replace the data in a matrix column with data bars 

 

 

 

 

 

 

 

 

 



 
Business Reporting: 

Leveraging Treemaps, 
Matrices, & Slicers in 

Power BI 
 

 

Objectives 
 
▪ create a treemap control in order to visualize data from a matrix, configure 

the color scheme of a treemap, and edit the data contained within the 
treemap 

▪ configure a treemap control to use another page as a custom tooltip 
▪ link a matrix with a treemap control so that if a matrix row is clicked, the 

tile corresponding to that row in the treemap is highlighted, and vice versa 
▪ edit the page view and page theme of a Power BI page and optimize a 

Power BI report for display on mobile devices using the mobile phone 
layout feature 

▪ create a slicer and add it to a Power BI report and configure the slicer to 
filter the UI of the report 

▪ edit a slicer so that all the options are represented by boxes to be selected, 
configure the slicer so that it can only have one item selected at a time, 
and create a range slider 

 

 
Final Exam: Decision 

Analyst 
 

Objectives 
 
▪ analyze information in multiple data tables related to one another 
▪ analyze your data at a higher level and drill down to a lower level 
▪ analyze your data at a higher level and drill down to a lower level based on a date field 
▪ apply conditional formatting and add data bars with custom colors to a matrix, then 

replace the data in a matrix column with data bars 
▪ combine files in an imported folder and perform basic data cleaning operations using 

Power BI's UI and Advanced Editor 
▪ configure a treemap control to use another page as a custom tooltip 
▪ configure the appearance of a map and explore the use of map layers 
▪ configure the filters pane in Power BI to automatically filter based on the specified filter 

value 
▪ convey information from multiple fields in your dataset using a variety of markers 
▪ create a column calculated from a formula using a new measure 
▪ create a dashboard and explore the various layouts available for the placement of objects 

such as charts 
▪ create a foreign key relationship (a.k.a., a referential integrity constraint) between two 

tables in Power BI 
▪ create and edit a line chart in Power BI by adding and configuring data labels, legends, 

markers, gridlines, and other chart elements 
▪ create a relationship between two tables in Power BI and enable automatic detection of 

these relationships 
▪ create a slicer and add it to a Power BI report and configure the slicer to filter the UI of 

the report 
▪ create a slicer and add it to a Power BI report and configure the slicer to filter the UI of 

the report 
▪ create a treemap control to visualize data from a matrix, configure the color scheme of a 

treemap, and edit the data contained within the treemap 
▪ create bar charts in Power BI, sort the values visualized in them, and edit the operations 

Power BI performs on the visualized data 
▪ create basic and advanced filters in Power BI to filter data using a condition on one or 

more columns 
▪ define the aesthetics of a Tableau chart to make it easier to analyze 
▪ develop a story to convey information in the form of visualizations by assembling charts 

and a dashboard 
▪ download the public version of Tableau and install it on your machine 
▪ edit a slicer so that all the options are represented by boxes to be selected, configure the 

slicer so that it can only have one item selected at a time, and create a range slider 
▪ edit the aesthetics of a bar chart, changing the color, display units, orientation, height, 

width, and more 
▪ edit the page view and page theme of a Power BI page and optimize a Power BI report for 

display on mobile devices using the mobile phone layout feature 



▪ embed an interactive web page, navigation button, and text label in a dashboard 
▪ enable a matrix to drill down to a specific level and then disable the matrix from having a 

drill-down 
▪ enable users to drill down in your visualizations by arranging related fields in a hierarchy 
▪ enrich your visualizations by conveying additional information using text 
▪ experiment Many: Many table relationships 
▪ experiment with 1:1, Many: Many, 1:Many, and Many:1 table relationships and create 

relationships among tables by dragging and dropping columns 
▪ explore the use of map layers 
▪ gather detailed information from Tableau charts by interacting with them 
▪ gather together related elements in your visualizations using groups 
▪ generate a basic visualization to analyze categories of data 
▪ generate multiple charts based on the same dataset for use in a dashboard 
▪ group related elements in your visualizations 
▪ illustrate different characteristics of your data by using a variety of charts available in 

Tableau 
▪ import JSON data into Power BI and use Power Query to convert JSON data into tabular 

data and change the column data types 
▪ import XML data to Power BI, filter it, and change the data type 
▪ import XML data to Power BI, filter it, change the data type, and find and delete rows with 

errors 
▪ install Power BI from Microsoft Store and import data to it from an Excel file 
▪ load data from a variety of file types into Tableau to perform an analysis 
▪ manually create and edit relationships between tables 
▪ perform operations in Power BI to remove columns and top rows, split columns by 

delimiter, filter rows, and delete a query 
▪ perform operations in Power BI using the UI and the Advanced Editor to sort data, change 

data types, rename columns, and use uppercase text 
▪ perform some basic data cleaning on your datasets using the Tableau data interpreter 
▪ perform sort operations on the rows and drill-down and drill-up operations on the rows 

and columns of matrix visualizations 
▪ perform various advanced Power Query operations, such as removing columns and Top 

N and error rows, performing row filtering operations, and creating grouped bar charts 
▪ plot country-related information on a Tableau Map 
▪ plot the changes in your data over time by using the Pages feature 
▪ portray different characteristics of your data by using a variety of charts available in 

Tableau 
▪ prepare your data for visualization by applying transformations, which are more 

meaningful for data analysis 
▪ recognize the different ways in which hierarchy definitions could lead to incorrect 

visualizations 
▪ recognize the properties of your data to choose the appropriate visualizations for analysis 
▪ Retrieving data. Wait a few seconds and try to cut or copy again. 
▪ set the aesthetics of a dashboard and include an option for the user to download the 

dashboard to a local file 
▪ Use Power BI to build and edit stacked line charts, configure aspects of them, such as the 

legend and axes, and create a basic filter in the filters pane 
▪ use Power Query to create conditional calculated columns usingif-else-elif blocks and 

custom calculated columns using formulas to determine values 
▪ use the Power BI Report View to visualize data that has been imported from an Excel 

spreadsheet and instantiate a matrix visualization in the report view 

 

 
Decision Analyst Lab 

 
 



 

Track 3: Systems Analyst (duration: 12h 10m 9s) 

 

 
Google Chart Tools: 

Basic Charts 
 
 
 
 
 

Objectives 
 
▪ assemble the pieces required to construct a simple chart using Google Charts 
▪ illustrate the different ways in which a data table can be created and populated using 

the DataTable class 
▪ demonstrate how Google Charts can be customized using several properties in an 

options object 
▪ customize the appearance and the data displayed in a Google chart 
▪ visualize your data in the form of a column chart 
▪ compare different series by rendering them alongside one another in a column chart 
▪ configure column charts to convey precisely the information you would like your users 

to view 
▪ define a column chart with multiple series stacked on top of one another to recognize 

their individual and aggregate impact 
▪ plot a material chart to visualize the same data viewed with a column chart 
▪ distinguish between the standard and material versions of Google charts 
▪ set up a combo chart with multiple visualizations for the same data 
▪ visualize a series of data using an area chart 

 

 

 
Google Chart Tools: 

Interacting with Charts 
 

Objectives 
 
▪ render the data present in a file on Google Drive in a Google chart 
▪ convey the relationship between two fields in your dataset using a scatter chart 
▪ use a chart editor to enable users to pick the best chart to visualize a dataset 
▪ recognize the various chart customizations available when using a chart editor 
▪ set up an interactive chart with a control within a Google Charts dashboard 
▪ design a dashboard containing multiple charts and multiple controls to define what 

data the charts should convey 
 

 

 

 

 

 

 



 
Google Chart Tools: 

Advanced Visuals with 
Charts 

 

Objectives 
 
▪ convey information related to countries by using a geo chart 
▪ plot locations on a map which can include satellite, street, or terrain information 
▪ portray the flow of data from a source to a destination using a Sankey chart 
▪ convey hierarchical information in your data using a treemap visualization 
▪ illustrate the various customizations available for a tree map 
▪ plot a value that falls within a range using a gauge chart 
▪ portray data for each day in a calendar year using a calendar chart 

 

 

 

 

 
Plotly for Data 

Visualization: An 
Introduction to Plotly 

Chart Studio 
 

 

Objectives 
 
▪ log in to the Plotly Chart Studio web console and create a new data grid 
▪ visualize preexisting data in a Chart Studio data grid in the form of a bar chart 
▪ recognize the different data formats that can be loaded into Chart Studio 
▪ use the Falcon client to integrate Chart Studio with the results of a query against 

a relational database 
▪ load one of the example charts in Chart Studio in order to recognize the features 

available to visualize data 
▪ define a Chart Studio table using data and formatting information set in a file 
▪ create and configure a bar chart in Chart Studio 
▪ define a plot that includes multiple traces in order to convey multiple series of 

data 
▪ summarize the key concepts covered in this course 

 

 

 
Plotly for Data 

Visualization: Exploring 
Chart Studio 

Visualizations 
 
 
 

Objectives 
 
▪ render a pie chart to analyze the proportion of contributions from various categories 
▪ create a plot with two charts by rendering them within subplots 
▪ view the relationship between two variables in your dataset by plotting them in a 

scatter plot 
▪ configure the axes of a plot to make them more prominent and make your charts 

easier to read 
▪ represent multiple dimensions of data in your scatter plot by configuring the points 

that are rendered 
▪ apply transform operations on your dataset in order to perform an aggregation 
▪ visualize sequential data using a line chart 
▪ augment your chart by including an annotation to convey additional information 
▪ view the distribution of values in a field by plotting a histogram 

 

 

 

 

 

 

 



 
Plotly for Data 
Visualization: 

Advanced Charts & 
Features in Chart 

Studio 
 

Objectives 
 
▪ visualize the distribution of numeric values in a field by rendering a box plot using 

Plotly 
▪ analyze the detailed distribution of numeric values in a field by creating a violin plot in 

Plotly 
▪ share your Plotly Chart Studio plots and data with viewers and collaborators 
▪ plot the variations in price of a tradeable asset using candlestick charts in Plotly 
▪ convey details about geographical regions using an atlas map in Plotly 
▪ use Plotly to render information about geographical regions by shading regions based 

on the value of a variable 
▪ analyze the stages of a sales cycle by generating a funnel chart in Plotly 
▪ use Plotly to visualize the proportional contribution of various categories that have a 

hierarchical relationship 
▪ combine related plots into a single page using a dashboard in Plotly 
▪ use Plotly to plot the relationship between two variables in your data by generating a 

fitted curve to map the relationship 
▪ use Plotly to analyze data over a long term by plotting a moving average curve 
▪ create Plotly Chart Studio plots from a Python app and upload them to your account on 

the cloud 
▪ define Plotly Chart Studio plots from a Python app and save them on your local file 

system 
 

 
SQL Programming with 

MariaDB: Getting 
Started with MariaDB 

for Data Analysis 
 
 

 

Objectives 
 
▪ install and launch MariaDB on Microsoft Windows, then connect to it from the 

command prompt 
▪ install and launch DBeaver as a user interface for MariaDB on Microsoft Windows 
▪ install and launch MariaDB on macOS, then connect to it from the terminal 
▪ install and launch DBeaver as a user interface for MariaDB on macOS 
▪ execute commands from the DBeaver environment 
▪ load data from a CSV file into a table using MariaDB 
▪ outline how to insert rows into tables 

 

 

 
SQL Programming with 

MariaDB: Analyzing 
Relational Data 

 

Objectives 
 
▪ use the following constraints: NOT, NULL, and UNIQUE 
▪ run a few basic SELECT-FROM-WHERE queries 
▪ use UNIQUE constraints in an in-depth and applied way 
▪ use update operations to update rows in tables, then create a table out of columns 

from another table 
▪ use the LIKE, NOT LIKE, IN, and NOT IN keywords work 
▪ use subqueries in their most fundamental application 
▪ constrain a child table from having any values in a column that are not in a specified 

column of the parent table using foreign key constraints 
▪ recognize and use the BETWEEN, LIMIT, and ORDER BY keywords 

 

 

 

 



 
SQL Programming with 
MariaDB: Using Joins, 

Triggers, & Stored 
Procedures 

 
 
 
 
 
 
 
 
 

Objectives 
 
▪ perform basic cross and inner joins using SELECT-FROM-WHERE queries 
▪ use the JOIN keyword to perform cross joins, inner joins, left outer joins, and 

right outer joins 
▪ recognize how default ON DELETE behavior of foreign key constraints in 

MariaDB works and perform a three-way join 
▪ override the default ON DELETE behavior of foreign key constraints in MariaDB 

tables to implement cascading delete 
▪ illustrate the basic usage of the DISTINCT and GROUP BY keywords 
▪ recognize different aggregate functions within GROUP BY queries and work with 

the HAVING clause to filter results of GROUP BY operations 
▪ Use the SOME, ALL and ANY keywords to link subqueries to outer queries 
▪ utilize generated columns in MariaDB 
▪ recognize what triggers are, implement an insert trigger, and observe its 

working mechanism 
▪ create and use an update trigger, which is executed after updates to a MariaDB 

table 
▪ invoke a stored procedure and pass in required arguments 
▪ start a transaction and execute statements within it, and either rollback or 

commit that transaction 
 

 

 

 
Final Exam: Systems 

Analyst 
 
 
 
 
 
 
 

 
 

Objectives 
 
▪ analyze the detailed distribution of numeric values in a field by creating a violin plot in 

Plotly 
▪ assemble the pieces required to construct a simple chart using Google Charts 
▪ combine related plots into a single page using a dashboard in Plotly 
▪ configure the axes of a plot to make them more prominent and make your charts 

easier to read 
▪ constrain a child table from having any values in a column that are not in a specified 

column of the parent table using foreign key constraints 
▪ convey details about geographical regions using an atlas map in Plotly 
▪ convey hierarchical information in your data using a treemap visualization 
▪ convey information related to countries by using a geo chart 
▪ convey the relationship between two fields in your dataset using a scatter chart 
▪ create and use an update trigger, which is executed after updates to a MariaDB table 
▪ create a plot with two charts by rendering them within subplots 
▪ customize the appearance and the data displayed in a Google chart 
▪ define a Chart Studio table using data and formatting information set in a file 
▪ define a column chart with multiple series stacked on top of one another to recognize 

their individual and aggregate impact 
▪ demonstrate how Google Charts can be customized using several properties in an 

options object 
▪ execute commands from the DBeaver environment 
▪ illustrate the basic usage of the DISTINCT and GROUP BY keywords 
▪ illustrate the different ways in which a data table can be created and populated using 

the DataTable class 
▪ illustrate the various customizations available for a treemap 
▪ install and launch DBeaver as a user interface for MariaDB on macOS 
▪ install and launch DBeaver as a user interface for MariaDB on Microsoft Windows 
▪ install and launch MariaDB on macOS, then connect to it from the terminal 
▪ install and launch MariaDB on Microsoft Windows, then connect to it from the 

command prompt 



▪ load one of the example charts in Chart Studio to recognize the features available to 
visualize data 

▪ log in to the Plotly Chart Studio web console and create a new data grid 
▪ merge related plots into a single page using a dashboard in Plotly 
▪ override the default ON DELETE behavior of foreign key constraints in MariaDB tables 

to implement cascading delete 
▪ perform basic cross and inner joins using SELECT-FROM-WHERE queries 
▪ plot a material chart to visualize the same data viewed with a column chart 
▪ plot locations on a map, which can include satellite, street, or terrain information 
▪ plot the variations in the price of a tradeable asset using candlestick charts in Plotly 
▪ portray the flow of data from a source to a destination using a Sankey chart 
▪ recognize and use the BETWEEN, LIMIT, and ORDER BY keywords 
▪ recognize different aggregate functions within GROUP BY queries and work with the 

HAVING clause to filter results of GROUP BY operations 
▪ recognize how default ON DELETE behavior of foreign key constraints in MariaDB 

works and perform a three-way join 
▪ recognize the different data formats that can be loaded into Chart Studio 
▪ recognize what triggers are, implement an insert trigger, and observe its working 

mechanism 
▪ render a pie chart to analyze the proportion of contributions from various categories 
▪ render the data present in a file on Google Drive in a Google chart 
▪ represent multiple dimensions of data in your scatter plot by configuring the points 

that are rendered 
▪ run a few basic SELECT-FROM-WHERE queries 
▪ set up a combo chart with multiple visualizations for the same data 
▪ set up an interactive chart with control within a Google Charts dashboard 
▪ share your Plotly Chart Studio plots 
▪ share your Plotly Chart Studio plots and data with viewers and collaborators 
▪ use a chart editor to enable users to pick the best chart to visualize a dataset 
▪ use Plotly to render information about geographical regions by shading regions based 

on the value of a variable 
▪ use Plotly to visualize the proportional contribution of various categories that have a 

hierarchical relationship 
▪ use the Falcon client to integrate Chart Studio with the results of a query against a 

relational database 
▪ use the following constraints: NOT, NULL, and UNIQUE 
▪ use the JOIN keyword to perform cross joins, inner joins, left outer joins, and right 

outer joins 
▪ use the LIKE, NOT LIKE, IN, and NOT IN keywords work 
▪ Use the SOME, ALL and ANY keywords to link subqueries to outer queries 
▪ use UNIQUE constraints in an in-depth and applied way 
▪ View the distribution of values in a field by plotting a histogram 
▪ view the relationship between two variables in your dataset by plotting them in a 

scatter plot 
▪ visualize a series of data using an area chart 
▪ visualize preexisting data in a Chart Studio data grid in the form of a bar chart 
▪ visualize the distribution of numeric values in a field by rendering a box plot using 

Plotly 
visualize your data in the form of a column chart 

 

 
Systems Analyst Lab 

 

 



 

Track 4: Data Architect (duration: 16h 21m 32s) 

 
VBA: Getting Started with 

VBA in Excel 

Objectives 
 
▪ customize Excel menus to display developer features, enter the VBA console, 

identify the default macro settings in the trust center, create an auto-open 
macro, display a message-box from VBA, associate the auto-open macro with 
an Excel workbook, and save that workbook as a macro-enabled (.xlsm) 
workbook 

▪ create an auto-close macro, contrast the working of the auto-open and auto-
close macros, compare functions and sub-routines in VBA, create a function 
that accesses the user name using the Excel object model, invoke that function 
from a worksheet cell, access and modify the contents of the active cell from 
VBA, use cell references with cell addresses from VBA, and invoke subroutines 
using the Macros>Run menu 

▪ edit the contents of a range of cells using direct cell references, an object of the 
Range class, and ActiveSheet.Range(), Sheet().Range(), and ActiveSheet 

▪ use VBA macros to autofit rows and columns, toggle the word-wrap setting of a 
range of cells, create a new macro using the Macro Recording feature, assign a 
keyboard shortcut to a recorded macro, and invoke that macro using the macro 
pane and keyboard shortcut 

▪ use relative references while recording a macro and recognize how it affects 
the output, accept user input using the InputBox function, and insert sheets 
into a Workbook from VBA 

▪ insert rows and columns from VBA, understand how errors in macros are 
displayed, and debug an error encountered while running a VBA macro 

▪ merge cells and center them and hide and unhide rows and columns 
▪ implement conditional formatting using VBA with a FormatConditions object, 

select all cells in a range that satisfy a certain condition, apply specific 
formatting to those cells, change the text and background color of cells, add 
buttons to an Excel workbook and associate them with specific macros 

▪ perform conditional formatting operations using VBA and simulate the use of 
arrow keys from within VBA using xlDown to go from the active cell to the last 
entry in a contiguous range 

▪ format a range of cells without using a format conditions object and recognize 
how removing formatting using a FormatConditions object will only remove 
formatting formatted using a FormatConditions object 

▪ insert a formula into a worksheet cell using absolute references from VBA, 
identify the limitations of xlDown when used without a clearly defined 
contiguous range around it, and use relative cell references and the size of a 
range to mitigate these limitations 

 

 

 



 
VBA: Building User 

Interfaces with Forms in 
VBA & Excel 

Objectives 
 
▪ introduce user forms as a way to add complex UIs to an Excel workbook and use 

the VBA forms control toolbox to add elements, such as buttons, to a user form 
▪ wire up a button to VBA code so that whenever that button is clicked a message 

is displayed, design a fully-fledged user form to accept complex user input using 
input boxes, and configure buttons to submit or reset that user input 

▪ wire up a complex user form to store data in an Excel workbook 
▪ add a button to a workbook to display a complex user form and demonstrate 

the resulting fully-fledged user application from Excel 
▪ use VBA's support for sending emails from within macros, enable and use 

Microsoft CDO (Collaboration Data Objects), recognize security flaws for 
sending emails from VBA, and identify the setup required if Gmail is the mail 
provider 

▪ develop a complex user form and add complex controls such as dropdown 
menus (known as combo boxes in VBA), checkboxes, radio buttons, and spin 
buttons 

▪ add complex controls to an app, including spin buttons and checkboxes, create 
a close button to unload the form's memory and cease displaying it, and add a 
submit button to store user input in a workbook 

▪ wire up the back-end code to process user inputs from the form, create a 
display button to show the form, and demonstrate the resulting fully-fledged 
user application from Excel 

 

 

 
VBA: Leveraging VBA to 

Work with Charts, Stocks, 
& MS 

Objectives 
 
▪ use VBA to create a pivot table and work with that pivot table both through 

VBA and directly via Excel 
▪ use VBA to create a simple chart on a new sheet and manipulate the data that it 

contains 
▪ change the chart type, format the chart to use 2-D as well as 3-D chart types 

from VBA, resize it, and save it as an image 
▪ work with Excel's Stock Data feature, which pulls in stock prices for specific 

financial assets 
▪ use VBA to automate the fetching of financial data and demonstrate the use of 

named ranges from within a VBA macro 
▪ illustrate the use of MS-Access, a lightweight relational database, and create a 

sample database (.acc) file and a table 
▪ specify the rows in a table as well as a primary key, import data from a CSV file 

into this table, and recognize how SQL queries work in MS Access 
▪ run SQL queries, such as SELECT-FROM-WHERE queries, to analyze data in MS 

Access 
▪ combine MS Access and VBA, add user forms to an Access database, configure 

various user controls, such as buttons and input boxes, and configure a 
calculated column based on an expression value 

▪ use SQL INSERT statements to add rows to the Access database based on user 
input to a form 

▪ demonstrate the use of event handlers in Excel, create a VBA subroutine to be 
executed when the user attempts to save a workbook, and add similar handlers 
for events, such as opening or closing a workbook 

▪ create an event handler for activating a worksheet, insert a new worksheet, and 
change the contents of a cell 

 

 

 



 
Using BigML: An 

Introduction to Machine 
Learning & BigML  

Objectives 
 
▪ recognize machine learning algorithm types and their applications 
▪ describe the process of using training data to construct a machine learning 

model 
▪ recall the various metrics used to evaluate the quality of a machine learning 

model 
▪ describe the features and use cases of linear regression 
▪ distinguish between supervised and unsupervised learning algorithms 
▪ recognize the purpose of clustering algorithms and list some of their use cases 
▪ describe the factors involved in extracting principal components from large 

datasets 
▪ recognize what association rules are and state their applications 
▪ list the features of BigML and the variety of models that can be built using this 

tool 
 

 
Using BigML: Getting 
Hands-on with BigML  

Objectives 
 
▪ recognize the features available in BigML to load data and train a machine 

learning model 
▪ load data from a variety of sources into BigML in order to train and evaluate 

machine learning models 
▪ organize your BigML resources into projects, such as data sources, datasets, 

and models 
▪ create a dataset out of a data source and analyze the different fields in the data 
▪ visualize relationships between various fields in a dataset 
▪ split and sample a dataset, which can then be used to train and test a model 
▪ build a classification model that uses a decision tree and recognize how this 

performs classification 
▪ illustrate the process involved in performing classification when a decision tree 

model is used 
▪ customize a decision tree model when performing classification 

 

 
Using BigML: Building 
Supervised Learning 

Models 
 

Objectives 
 
▪ use BigML to build an ensemble of decision trees to solve a classification 

problem 
▪ recognize the properties of ensemble models configured in BigML 
▪ compare the performance of a small ensemble with a larger one 
▪ prepare a dataset for use in a linear regression model 
▪ build a linear regression model and identify the relationships it uncovers 

between the input variables and the output 
▪ recognize the different factors involved in evaluating a linear regression model 
▪ describe the process of preparing a dataset for logistic regression 
▪ train a logistic regression model to predict an output based on probability of 

occurrence 
▪ check the performance of a logistic regression model using a test data 
▪ create a time series model using several years' worth of data 
▪ apply past data to make future forecasts using a time series model 
▪ apply a brute-force approach to find the optimal model for your dataset 

 

 

 



 
Using BigML: Unsupervised 

Learning 
 

Objectives 
 
▪ generate clusters in your input data and analyze the properties of each cluster 
▪ illustrate the features of the various clustering models that can be configured in 

BigML 
▪ create models from your cluster instances to identify the factors that affect 

cluster membership 
▪ identify associations in a collection of transactions to find items purchased 

together 
▪ extract discussion topics in a collection of text-based product reviews 
▪ find the principal components in a dataset containing several fields 
▪ identify the anomalies in a dataset using BigML's anomaly detection model 

 

 
Analyzing Data Using 

Python: Data Analytics 
Using Pandas 

Objectives 
 
▪ create a pandas Series object 
▪ perform basic operations on Series objects 
▪ cast data types within Series objects 
▪ filter data in Series objects using logical operations 
▪ create the tabular DataFrame object in pandas 
▪ look up data using DataFrame methods 
▪ create DataFrames from dictionaries and tuples 

 

 

 
Analyzing Data Using 
Python: Importing, 

Exporting, & Analyzing 
Data With Pandas 

 

Objectives 
 
▪ import and export data in CSV files 
▪ import and export data using HTML and JSON files 
▪ serialize data to Excel and Pickle files 
▪ perform basic data manipulation operations on DataFrames 
▪ explore and edit data in DataFrames 
▪ sort records based on column values 
▪ compute basic statistics on data stored in DataFrames 
▪ compute statistical summaries on data stored in DataFrames 

 

 

 
Analyzing Data Using 

Python: Filtering Data in 
Pandas 

 

Objectives 
 
▪ look up data using different techniques 
▪ apply the loc and iloc functions to access specific rows and columns 
▪ filter data using the loc, iloc, at, and iat functions 
▪ filter data using the loc, iloc, at, and iat functions 
▪ perform conditional filtering using the query function 
▪ parse and manipulate datetime values 
▪ select and drop specific columns 
▪ apply regular expressions and other advanced techniques to select and drop 

columns 
 

 

 

 

 



 

 
Analyzing Data Using 
Python: Cleaning & 

Analyzing Data in Pandas 
 

Objectives 
 
▪ identify and deal with duplicate records 
▪ summarize records into bins or categories 
▪ compute aggregations on data 
▪ perform common grouping and aggregation operations 
▪ use pivot tables to explore data 
▪ use pivot tables to summarize data 
▪ combine and merge records 
▪ perform inner join operations using the merge() method 
▪ perform left and right join operations using the merge() method 
▪ implement joins using the join() method 
▪ manipulate and analyze time series data 

 

 

 
Final Exam: Data Analyst 

 

Objectives 
 
▪ add a button to a workbook to display a complex user form and demonstrate 

the resulting fully-fledged user application from Excel 
▪ add user forms to an Access database and configure various user controls 
▪ apply a brute-force approach to find the optimal model for your dataset 
▪ apply basic data manipulation operations on DataFrames 
▪ apply the loc and iloc functions to access specific rows and columns 
▪ cast data types within Series objects 
▪ compare the performance of a small ensemble with a larger one 
▪ compute aggregations on data 
▪ create a dataset out of a data source and analyze the different fields in the data 
▪ create a pandas Series object 
▪ create macros 
▪ create models from your cluster instances to identify the factors which affect 

cluster membership 
▪ create pandas Series objects 
▪ customize Excel menus to display developer features 
▪ demonstrate the use of MS-Access, a lightweight relational database, and 

create a sample database (.acc) file and a table 
▪ describe the features and use cases of linear regression 
▪ describe the features of clustering models which can be configured 
▪ describe the process in which a machine learning model is constructed using 

training data 
▪ describe the process of preparing a dataset for logistic regression 
▪ edit the contents of a range of cells using direct cell references 
▪ filter data using the iloc function 
▪ filter data using the loc, iloc, at, and iat functions 
▪ generate clusters in your input data and analyze the properties of each cluster 
▪ identify and deal with duplicate records 
▪ identify the features of clustering models which can be configured 
▪ illustrate the use of MS-Access, a lightweight relational database, and create a 

sample database (.acc) file and a table 
▪ import and export data in CSV files 
▪ import and export data using HTML and JSON files 
▪ import data from a CSV file 
▪ introduce user forms as a way to add complex UIs to an Excel workbook and use 

the VBA forms control toolbox to add elements, such as buttons, to a user form 
▪ load data from a variety of sources into BigML to train 



▪ load data from a variety of sources into BigML to train and evaluate machine 
learning models 

▪ lookup data using different techniques 
▪ navigate Visual Basic editor 
▪ organize your BigML resources such as data sources, datasets and models into 

projects 
▪ perform a brute-force approach to find the optimal model for your dataset 
▪ perform basic data manipulation operations on DataFrames 
▪ perform basic operations on Series objects 
▪ perform common grouping and aggregation operations 
▪ perform inner join operations using the merge() method 
▪ recall the various metrics used to evaluate the quality of a machine learning 

model 
▪ recognize the features available in BigML to load data and to train a machine 

learning model 
▪ recognize the properties of ensemble models which can be configured in BigML 
▪ recognize the purpose of clustering algorithms and list some of its use cases 
▪ recognize the types of machine learning algorithms and their applications 
▪ run SQL queries, such as SELECT-FROM-WHERE queries, to analyze data in MS 

Access 
▪ serialize data to Excel and Pickle files 
▪ specify the rows in a table as well as a primary key, import data from a CSV file 

into this table, and recognize how SQL queries work in MS Access 
▪ summarize records into bins or categories 
▪ train a logistic regression model to predict an output based on the probability 

of occurrence 
▪ use BigML to build an ensemble of decision trees to solve a classification 

problem 
▪ use inner join operations using the merge() method 
▪ use relative references while recording a macro and recognize how it affects 

the output, accept user input using the InputBox function, and insert sheets 
into a Workbook from VBA 

▪ use shortcut keys to navigate Visual Basic Editor 
▪ use SQL INSERT statements to add rows to the Access database based on user 

input to a form 
▪ use the loc and iloc functions to access specific rows and columns 
▪ use VBA macros to autofit rows and columns 
▪ use VBA's support for sending emails from within macros 
▪ wire up a button to VBA code so that whenever that button is clicked, a 

message is displayed, design a fully-fledged user form to accept complex user 
input using input boxes, and configure buttons to submit or reset that user 
input 

▪ wire up a complex user form to store data in an Excel workbook 
 

 

 
Data Analyst Lab 
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